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MEMORANDUM FOR ALL ACC COMMANDERS

FROM:
ACC/CC

205 Dodd Boulevard, Suite 100

Langley AFB VA  23665-2788
SUBJECT:  Commander’s Guide to Managing E-Mail

1.  Information overload is a common occurrence for today’s warrior.  There are daily conscious choices we all must make to try and manage the volumes of information we receive.  For example, what E-mails to read first, how to construct replies, which ones to delete, and what simple e-mail etiquette is.  This guide is our first step to help you manage this important tool.

2.  I expect today’s leaders to be the catalyst for any change initiative of this magnitude.  Commanders will set the tone for how e-mail is used to meet mission requirements.  If you accomplish activities primarily through e-mail and apply good business rules and standards, your troops will follow.  


3.  Using e-mail can be a great avenue for accomplishing a diverse set of tasks in an expedient manner but should not replace the time spent away from the computer to deal face-to-face with critical Air Force issues.  I challenge all airmen to use this guide, and be a part of the ACC team effort to reduce and effectively manage the amount of e-mail we receive.
                    [image: image1.jpg]



HAL M. HORNBURG
                                  General, USAF
                                  Commander
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COMMANDER’S “TOP TEN” LIST ON E-MAIL

· E-mail can come back to haunt us; establish/enforce rules to eliminate inappropriate/potentially damaging material.
· Sending recurring e-mail traffic and updates to our subordinates is not a replacement for commander’s calls.
· Assign a designated individual or individuals to monitor the organizational e-mail account inbox regularly to ensure messages requiring action are acted upon promptly.
· Subject lines should include keywords and describe the content of the message.  (This helps recipients prioritize, file, and search for messages.)

· Official e-mail will include “//SIGNED--initials//” in upper case before the signature block to signify it is official. They will not contain slogans, quotes, logos, graphics, digital images, clip art, etc., unless required as part of the e-mail content.
· Before posting to public web pages ensure For Official Use Only files are cleared by the OPR and/or Public Affairs or Judge Advocate. 
· Communicate through/to organizational e-mail boxes to ensure issues are acted on when personnel are away.
· Only reply to e-mail that absolutely requires a response and minimize the use of the “Reply to All” function.
· E-mail is considered an official government record and is legally searchable on your computer and subject to record retention policies.
· Use caution when sending e-mail messages to mass distribution lists; establish approval coordination/release processes for central unit release (i.e., exec officers).

EFFECTIVE WRITING

· Organizational e-mail will follow specific formats found in AFMAN 33-326, Preparing Official Communications and AFH 33-337, The Tongue and Quill.
· Use the basic elements of effective writing:  clarity, brevity, and courtesy.
· Make your most important point in the first sentence or paragraph.
· Edit messages for spelling and grammatical errors.
· Use acronyms or abbreviations when feasible, but spell them out the first time they are used.
· Cite all quotations, references, and sources.
· Do not use unprofessional language and limit sarcasm and humor.

· Clear e-mail flags before forwarding…if overdue they’ll go red in the recipients box, too.
EXECUTIVE OFFICER ROLES

Organization executive officers are the critical link to ensure commanders’ e-mail policies and capabilities are met.  The five areas below highlight the more visible e-mail priorities that are inherent in their positions:

Organizing the Inbox

There is no one-size solution to structuring inboxes for your commanders but many have used a 4- or 5-level scheme to help them sift through the most critical information efficiently and to minimize time.  We provide a sample structure below:

· HOT – items that must be responded to within the day.
· Commander Information – Correspondence from commanders/peers.
· MEDIUM – Important traffic, but does not require immediate attention.
· Routine – Non-timely information that can be viewed any time.
· EPRS/Decorations – A placeholder for these requirements to separate them from other day-to-day requirements.
Managing Outlook Mailboxes

Once structured according to a system that is comfortable for the commander and the executive staff, the primary requirements will be managing the information flow for your boss.  It is important that you arrange through your local communications unit to establish an organization box on the server.  Then, executive officers can transfer incoming messages to appropriate folders to help commanders prioritize the most important e-mail to review.  Effective management of commanders’ incoming e-mail can save valuable time.

In addition, commanders require a filing system to quickly retrieve important messages, to document important decisions, and reference as needed.  Executive officers should establish a filing structure in the commander’s Microsoft Outlook Personal Folders which mirrors an office file plan to allow records to be maintained along with other official organizational records.  It is important to create this directory in the “personal folders” area because that information is stored on your desktop and not on the e-mail server.   Note:   By creating personal folders you run the risk of data being lost.  That is why it is best to create files on your server and then that way they are backed up by the local communications unit.  The network control center typically limits the amount of e-mail space allotted and the commander’s allotment can exceed that space.
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MID-LEVEL MANAGER TIPS
· Protect your bosses and peers; share e-mail with them that could impact their position of authority.
· Don’t use e-mail as a crutch to avoid boss/commander interaction with subordinates.
· Don’t send e-mail directly to commanders; use the supervisory channels instead.
· Allow subordinates and supervisors to review e-mail provided directly to senior leadership if they are affected and there is no harm in doing so.
· Don’t assume your e-mail is received and understood; follow up on accuracy of the tasking or question.
· Work smarter, not harder; prevent e-mail generated because subordinates have not been informed.
· Save critical e-mail to provide a trail for any key decisions made as backup information.
· Summarize up front if forwarding a message with a long string of replies.
· Preserve receipts and acknowledgments that show delivery and disposition status of important messages.
· Report suspected violations of e-mail policy to your supervisor, information protection office, or e-mail administrator.
· When leave or TDY prevents you from accessing your mail, turn off or suspend mail from any mailing lists or list servers.
· Be responsive to e-mail, no matter where it initiates.
· Be careful when using e-mail distribution lists to ensure you don’t arbitrarily send messages to unintended audiences.
· Determine how others manage their e-mail requirements and share cross tells.
· Maintain sent and received e-mail according to Air Force records management directives.
· Remember e-mail is subject to Privacy Act of 1974 and the Freedom of Information Act.
ACTION OFFICER STAFFING AND E-MAIL ADVICE

Action officers are faced with difficult and often unrealistic expectations as a result of the technology enhancements incorporated into our staffing processes.  Although these enhancements improve efficiency and save valuable time, action officers still require training to effectively utilize these electronic tools and time to research, coordinate, and staff their projects.

Professional Courtesies
· Follow the chain of command when sending messages to a higher organizational level as with any other medium.  Send courtesy copies as necessary.
· Use caution when sending an e-mail message to large distribution lists—send to intended audiences only.
· Use organizational e-mail boxes to communicate from organization to organization; standardize organizational    e-mail boxes IAW AFI 33-119, A6.5.
· E-mail text normally should not exceed three paragraphs or one screen when maximized.
· Avoid cyber-speak.  Not everyone is familiar with the acronyms used in e-mail messages, such as IMHO (in my humble opinion), WRT (with respect to), or FWIW (for what it’s worth).  Performing a mental translation each time slows down the reader.
· Use the blind courtesy copy (bcc) feature for e-mail distribution lists.  By using the “bcc” feature, recipients won’t be able to copy names and e-mail addresses.
· Include your signature block and phone number at the bottom of all e-mail to ensure recipients can identify/contact the originator.
· Capitalize words only to highlight an important point or to distinguish a title or heading.  Capitalizing whole words that are not titles is considered SHOUTING.
· Be sure to include attachments when “replying” to e-mails if the receiver will need them.

· Be professional and careful whenever writing about others. E-mail is easily forwarded, and messages intended to be private or personal may not remain so.
· Use a tone that is appropriate to the recipient.
· Use Outlook flags only to highlight suspense’s and high-priority messages, and remove the flag before forwarding up the chain.
· Use the Outlook tasker function to indicate tasks and required response dates.
· Send calendar items instead of listing dates and locations inside e-mail.
· Cite all quotations, references, and sources.
· Watch the use of unprofessional language and limit the use of sarcasm and humor. 

· Sending large files such as digital images to a large number of recipients will delay other traffic and may overload the system.

· Don’t use fancy background graphics that eat up additional server space and get in the way of the intended message.
· Edit messages for spelling and grammatical errors.  A poorly written message will interfere with the importance of the message.
· Link large files sent within e-mail from shared drives or web sites. 

· Avoid including pictures in e-mail messages if possible.
Military Etiquette

· E-mail destined for mass distribution outside your organization should be approved/released from unit executive officers.
· Exec officers screen and distribute all e-mail destined for multiple organizational boxes (2- and 3- letter traffic).
· Secretaries and information management personnel screen and disseminate e-mail disseminated to multiple 4-digit offices and multiple distribution lists.
· Don’t impose unrealistic suspense timelines just because it is quicker to coordinate packages through e-mail.
· Establish acceptable lead time for suspense’s and redistribute taskings to appropriate OPRs quickly.
· Visit POCs to discuss important issues versus sending e-mail. 

· Post fundraisers, flyers, etc., to central web site or shared public e-mail folders vice sending to mass recipients.
· Don’t send or respond to “jokes of the day” and unofficial message traffic.
· No “unofficial” e-mail traffic to external unit recipients.
E-Mail Alternatives

· NCCs should establish user permission restrictions for distribution lists—limit release for these lists to executive officers, workgroup managers, and secretaries

· A simple phone call with a voice message or visiting someone to address concerns will save many e-mails to achieve the same results.
· Make use of Macros to filter and prioritize your e-mail.
· Place information on shared drives, public folders, or provide a URL to a web server to view attachments 

OFFICIAL USE AND AUTHORIZED USE OF E-MAIL SYSTEMS

Official Use 

Includes communications the Air Force determines necessary in the interest of the Federal government.  Also includes those communications by military members and other Air Force employees who are deployed for extended periods away from home on official business when approved by the theater commander in the interest of morale and welfare.
Unofficial Use

· Do not distribute copyrighted materials.
· Do not send or receive e-mail for personal or financial gain.
· Do not send harassing, intimidating, abusive, or offensive material.
· Do not use someone else’s identity or password.
· Do not propagate chain letters, inappropriate messages to groups, or use up storage space on the e-mail server.
Authorized Personal Use

· Serves a legitimate public interest.
· Conforms with theater component commander and MAJCOM polices.
· Does not adversely affect the performance of official duties.
· Is of reasonable duration and frequency and is accomplished during personal time.
· Does not overburden the communications system.
· Does not create additional costs to DoD or the Air Force.
· Does not reflect adversely on DoD or the Air Force.
Examples of Authorized Limited Use

· Brief communications made while traveling on official business to notify family members of official transportation or schedule changes.
· Exchanging time-sensitive information with a spouse or other family members, such as scheduling doctor, automobile, or home repair appointments, etc.

· Educating or enhancing the professional skills of employees.
· Improving the morale of employees stationed away from home for extended periods.
· Job searching in regards to Federal government downsizing.
SECURITY

· Use only approved systems in approved facilities by properly cleared personnel.
· Use electronic delivery receipts when transmitting classified information off the installation or to non-Air Force activities.
· Do not transmit unclassified information requiring special handling (i.e., encrypt for transmission only [EFTO]), on or to systems not approved for that purpose.
· Do not discuss over any unprotected or open unclassified network any operational security (OPSEC) mission critical information items.
· Destroy classified e-mail when it’s marked for destruction.
· Verify security clearances against valid visitor request(s) or with unit security managers.
· Mark classified e-mail with appropriate security markings.
· Mark all paragraphs and subparagraphs with their classification in the same manner as normal correspondence.
· Include declassifying and downgrading instructions.

RECORDS MANAGEMENT

· Maintain sent and received information according to Air Force records management directives, AFI 37-123, Management of Records.
· Preserve the content, context, and structure of records in a useable format for their authorized retention period.
· Make records easily accessible for individuals who have an official requirement to access them.
· Arrange e-mail records in accordance with the approved file plan.
· Preserve e-mail system and transmission data that identifies users by codes, nicknames, addresses, and distribution lists to ensure you can identify originators/ recipients of official messages.
OFF-SITE STORAGE

Keep archived E-mail files as necessary for system reconstruction after catastrophic system failure in a secure area and physically separated from the NCC e-mail server.
ATTACHMENT 1 - TIPS FOR MANAGING E-MAIL 

Saving E-Mail Space

There are many handy ideas that can help save valuable server space and help users more effectively track and manage their e-mail accounts.  The five steps provided below are just a few options users should understand and become familiar with.
1.  Create Personal Folders.  Create personal folders (.pst files) and move e-mail you would like to keep in those folders.  Note:  E-mail that is moved to personal folders is stored on your PC and cannot be viewed when using Web mail.  Make sure you frequently backup your personal folders (If you lose your PC hard drive and did not back up your e-mail files, you have lost your old e-mail.)   Note:  Microsoft experts recommend that .psts be no larger than 1 GB.  If your file gets close to this size it is best to create another one.
2.  Delete Sent Mail.  Frequently check and delete (or move to a personal folder) all sent mail.  If you would like to keep your sent mail, store it in a personal folder or your official files.

3.  Delete E-Mail in Deleted Items Folder.  Frequently check your deleted items folder and empty contents, or set up your e-mail to automatically empty upon exiting.
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4.  Use Out of Office Assistant.  Turn on your “Out of Office Assistant” when TDY, on leave, or deployed.   
5.  When TDY or On Leave and Away From Your Office.  If you are TDY or deployed for an extended period, have your system administrator (SA) remove you from distribution lists (For example:  37 CS All Personnel).  When you return, have your SA add you back to distribution lists. 
Using Keyboard Shortcuts

Once you discover keyboard shortcuts, you may find it tough to use your computer without them.  Here are a few important keyboard shortcuts you can use to manage e-mail messages in your Outlook Inbox:

· Press CTRL+D to delete the current e-mail message.
· Press CTRL+R to reply to the current e-mail message.
· Press CTRL+F to forward the current e-mail message.
· Press CTRL+C to copy highlighted text.
· Press CTRL+V to paste highlighted text.
Managing Junk E-Mail

If you find that the amount of junk mail in your Inbox has gotten out of hand, Outlook offers a number of features that make it easier to control the influx of unsolicited messages.  For example, Outlook can search for commonly used phrases in e-mail messages and automatically move messages containing these phrases from your Inbox to either a junk e-mail folder created by Outlook, to your Deleted Items folder, or to any other folder you specify.  To learn how to automatically remove junk mail from your Inbox, click on http://www.microsoft.com/office/previous/xp/columns/column01.asp
You can filter unwanted messages by e-mail address.  As you receive unwanted e-mail messages, just create a list of the e-mail addresses of these senders.  To do this, right-click the message, point to Junk E-Mail, and then click Add to Junk Senders list. 

When you first begin using these features or when you make modifications to them, you should review messages that are automatically removed from the Inbox to make sure that any pertinent messages are not accidentally removed.

To automatically delete, move, or color-code all junk e-mail messages:

1. On the toolbar, click Organize
2. Click Junk E-mail
3. Select the options you want, and click Turn on for each set of options you choose
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Using the Auto Archive Feature

As you create and receive e-mail messages and other items, your Outlook mailbox will grow.  To keep your mailbox manageable, archive old items that are important enough to keep but that you don't access frequently.  The outlook auto archive feature takes care of these processes for you automatically. 


Auto Archive runs at scheduled intervals, clearing out old and expired items from folders; it is turned on by default.  An item is considered old when it has been in your Inbox for a period of time that you specify (say, 6 months).  Expired items are mail and meeting items with content that is no longer valid after a certain date, such as a meeting you had 4 months ago that still appears on your calendar. 


After Outlook archives items for the first time, you can access items in the file directly from Archive Folders in your Folder List. (To view the Folder List, from the View menu, click Folder List.)  If you want, you can have separate archive files for individual folders. 


When you open Archive Folders, you'll see that Outlook maintains your existing folder structure, making items easy to find.  If you want to move archived items back into your main mailbox, you can move or copy them into their original folders or into other folders.
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For example, Outlook can search for commonly used phrases in e-mail messages and automatically move messages containing these phrases from your Inbox to either a junk e-mail folder created by Outlook, to your Deleted Items folder, or to any other folder you specify.

Auto Managing Incoming Messages

You can set up rules to have Outlook help you manage incoming e-mail messages.  For example, Outlook can:

· Alert you when you receive a message from your supervisor 

· Move messages that have the text "Meeting Minutes" in the Subject line to your Meetings folder 

· Flag incoming messages that are from a distribution list

Cleaning Up Your Mailbox

You can quickly clean up your Outlook mailbox to reduce the amount of distracting mailbox clutter. To use this feature:

1. On the Tools menu, click Mailbox Cleanup. 

2. Select options to find old or large items to move or delete. 

3. Do one of the following: 

· Click Auto Archive to move old items to Archive Folders
· Click Empty to permanently delete items from your Deleted Items folder
· To see where the archive folders are stored, right-click the Archive Folders folder in your Folder List, click Properties for Archive Folders, click Advanced, and look at the Filename box
· To customize archiving behavior, on the Tools menu, click Options, click the Other tab, and click Auto Archive
Use Personal Folders to Store Information

When you create messages, appointments, tasks, and journal entries, Outlook saves the information on your computer in a data file known as a Personal Folders file which has the file extension .pst.  (However, if you use Microsoft Exchange Server, your e-mail messages, calendar, and other items are delivered to and stored on the server).  The Personal Folders file can be a useful way to organize and back up Outlook items without overloading the        e-mail servers. 

For example, if you want to organize Outlook items into specific folders, you can create an additional data file for each category. One possibility would be to keep all messages from a specific company in a separate data file.  When you create the data file, you can use any name for the file.

USING RULES FUNCTIONALITIES IN OUTLOOK

Are you overwhelmed by the number of e-mail messages in your Inbox?                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                          Instead of constantly organizing an ever-growing number of messages manually, use the Rules Wizard to help you automatically process and organize your messages. After you use the Rules Wizard to create a rule, Microsoft Outlook applies it when messages arrive in your Inbox, or when you send a message.  

Use Rules to Run Your Inbox 

Make Outlook do the work of filing, deleting, highlighting, forwarding, and prioritizing incoming and outgoing messages. With the Rules Wizard, you can automatically send undesirable e-mail to a "junk" folder or be alerted by a specific sound when you receive an urgent e-mail message.  Once you set the rules, you can apply them to clean up the backlog of messages already sitting in your Inbox.  To get started, open the Tools menu, click Rules Wizard, and then follow the instructions on your screen.  To get specifics on how to use rules effectively, read Tips for Managing Your E-Mail Using Rules in Microsoft Outlook (http://office.microsoft.com/assistance/2002/articles/OlTipsToManageEmailUsingRules.aspx).
What is a Rule?

In Microsoft Outlook, a rule is a set of conditions, actions, and exceptions that processes and organizes messages automatically and that is triggered by an event. 

Think of the relationship between the event, condition, action, and exception this way: 

· An event triggers the rule.  For example, you can select, “Check Messages” when they arrive as the event.
· A condition specifies the messages that the rule will apply to. For example, you can select sent only to me or where my name is in the Cc box as conditions.  You can select one or many conditions.  If you do not select any conditions, it is the same as selecting all conditions

· An action specifies what should be done with qualifying messages. You can select one, many, or no actions.  For example, you can select delete it if you do not want to read messages that have the word "jokes" in the Subject line.
· An exception specifies which messages will not be affected by the rule.  You can select, one, many, or no exceptions.  A rule is not applied to a message if any one of the exceptions you specify is met. For example, you can delete all messages with the word "jokes" in the Subject line, except those from your boss (whose jokes you like).
What Can I Use Rules For? 

You can automatically: 

· Move messages to a particular folder based on who sent them.
· Move certain kinds of messages, such as “Out of Office” messages, to another folder.
· Delete messages in a conversation.
· Flag messages from a particular person.
· Set up a notification, such as a message or a sound, when important messages arrive.
· Redirect a message to a person or to a distribution list. 

· Ask the server to automatically reply to a certain type of message by using a message you've created.
· Assign categories to messages you send based on the contents of the messages.
· Delay delivery of messages by a specified amount of time. 

· Start a program.
Order the Sequence in Which Your Rules Operate 

· Order your rules with the following in mind:  Rules running on the server, such as Microsoft Exchange Server, always operate first, followed by those running in Outlook on your computer.
· Within these two categories, you can change the order in which your rules operate by moving them up or down in the “Apply Rules in the Following Order” list in the Rules Wizard. Just select a rule, and then click “Move Up” or “Move Down.”
· To apply rules only to the messages on your computer, select on this machine only as a condition.
· To avoid multiple rules operating on the same message, especially if you don't want the bottom-most rule to prevail when multiple rules apply, select “Stop Processing More Rules” as an action.
Avoid Inadvertent Errors When You Create Rules 

· To avoid mistyping, create rules based on a message.  Open a message, and then at the Actions menu, click Create Rule. Many conditions and exceptions are filled in for you.
· To test newly initiated created rules, select “Run This Rule Now” on messages already in the "Inbox".
· To back up your rules by exporting them to an .rwz file in the Rules Wizard dialog box (Tools menu, Rules Wizard command), click Options, and then click Export Rules.  You can even import this file to another computer or to a laptop, so you don't have to recreate your rules and risk introducing errors in the process.
Speed Up Processing Your Rules 

· Avoid conditions and exceptions that search for words in the message body.  Unless your e-mail messages are short, this search could take a long time.
· Select “With Specific Words” in recipient's or sender's address as a condition instead of “Sent to People or Distribution List” or from people or distribution list.  Searching for a specific name or word in the To or From field is faster than searching through distribution lists.
In much the same way that retailers and businesses use mailing lists of postal addresses to send potential clients catalogs and other information, others use e-mail messages as a direct marketing tool.  If you do not want to receive these messages, Microsoft Outlook can automatically move them from your Inbox to your Deleted Items folder or to any other folder you specify. Outlook creates a folder called Junk Mail where you can move junk e-mail and then review it before deleting.  Or you can have junk e-mail delivered to your Inbox but color coded so you can easily identify it. The list of terms that Outlook uses to filter suspected junk e-mail messages can be found in a file named Filters.txt.
You can also filter messages based on the e-mail addresses of junk senders, allowing you to move or delete all future messages from a particular sender.  You can review the Junk Senders list and add and remove e-mail addresses from it.

FILING E-MAILS TO FILE PLAN
Assumption:  One OPR per project.

Create a folder in your file plan (coordinate this with the Records Custodian).

While in Outlook create a .pst that will be located in your office’s file plan.  Go to File drop down menu.  Select New/Outlook Data File…Click on OK at the next screen and you will get a “Create or Open Outlook Data File” screen.  Type in your file Name (the same file folder name you will use in your electronic file plan folder). 
Next screen is “Create Microsoft Personal Folder”.  At “Name” prompt, type in the folder name again.  
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Create a rule to have emails on this subject to be delivered directly to that box using Tools/Rules Wizard.
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The person who created this folder can share this folder with OCRs.  The OPR has all the emails on this subject filed in a central location that can also be accessed by coworkers and the boss.  
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